
Adding Files

This option allows you to add files to an already open archive.    Any number of files can be added to the 
archive, password protected, etc.    See Creating New Archives for more information on the adding files screen 
and it's options.

Note:    Files cannot be added to an existing archive that was created using Multiple Disk Mode.



Adding Comments
You can add a comment into any archive at any time.    The text comment will be displayed to the user when the 
archive is opened, as long as the user has their configuration set to do so.

Comments can contain any ASCII characters and can be a maximum of 255 characters long.

Note:    Comments cannot be added to archives created in Multiple Disk Mode or Self-Extracting (.EXE) 
archives.



Configuration Settings
This menu allows you to set several configuration defaults for QuikZip operation.    Select this option by 
choosing the Configuration menu and clicking Configuration Settings.    The following tab options are available:

General

Archive Comment - Opening Archives

Always Show
Never Show
Prompt

When any archive is opened, the setting here will determine the action of QuikZip where an archive comment is 
concerned.    The comment will be always shown if this option is set, never shown if selected, or QuikZip will 
inform you of an archive comment and allow you to view it or not.    The last option is the default setting.

Archive Comment - Creating Archives

Always Add
Never Add
Prompt

When any archive is created or opened, the setting here will determine the action of QuikZip where an archive 
comment is concerned.    The comment screen will appear automatically each time a new archive is created or 
files are added to an open archive, allowing you to add a comment to the archive if always add is selected, 
while the screen will never be shown if never is selected.    QuikZip will ask    you if you wish to add a comment 
to the archive if prompt is selected.    The last option is the default setting.

Verifi System

Always Add
Never Add
Prompt

When any archive is created or opened, the setting here will determine the action of QuikZip where the Verifi 
System is concerned.    QuikZip will automatically add the Verifi System into a new archive or an open archive 
if the always add option is selected and if it is not already present in the archive.    The Verifi System will never 
be added if the never option is selected, while QuikZip will ask    you if you wish to add the Verifi System if 
prompt is selected.    The last option is the default setting.

Scanner

Scanner Location

Allows you to enter the full path and name of the virus scanner you wish to use within QuikZip.    Use the 
'Browse' button to select a scanner.

Command Line Switches

Allows you to set any commands that should also be passed to the scanner when an operation is performed.    
By default, /NOMEM is set.    This option tells most virus scanners to scan the passed files only and not 
memory.    You can set any switches here you wish, or clear the contents entirely to pass no switches to your 
virus scanner.    Consult your virus scanner documentation for optional command line switches.

When these options are set and an archive is open, you will be able to choose the Scan option under the option 
menu to scan the contents of the opened archive.



Options

Display Gridlines

Determines is gridlines are displayed in the file listing or not.    Gridlines are off by default.

Select Files when Mouse Hovers

Determines if files are selected automatically when the mouse hovers over top of them in the file listing.    This 
option is on by default.

Full Row Select

Determines if the entire row information is selected when a individual file is clicked.    Full row select is on by 
default.
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Convert Zip to Self-Extractor
This option allows you to quickly and easily convert an existing Zip archive into a Self-Extracting (.EXE) 
archive.

Once selected, QuikZip will allow you to select an existing Zip archive to convert and proceed with the 
conversion.

When the conversion process is complete, an archive in Self-Extracting form will be created in the same folder 
as the existing Zip archive, with the same name, other than the (.EXE) extension.

The original Zip archive will remain intact and will not be affected by the conversion.



Creating Desktop Shortcuts
By selecting this option from the Options menu or the Right Click menu, you will be able to create a Shortcut on 
your Windows Desktop for the currently selected file.

QuikZip will prompt you for a destination folder to store the file in, extract it from the archive and then create the 
Desktop Shortcut.

Note:    A shortcut can be created for any valid file.    If the shortcut if for a program (.EXE file), ensure no 
other files in the archive are needed to run the program, or it will not work.



Creating New Archives
This option allows you to create a new ZIP or EXE archive.    You will first be prompted for the archive 
destination folder and name.    The add files screen will then allow you to add files to the archive.

The add files screen has the following options:

Action:

Determines the type of action the selected files will be added to archive with.

Add(and Replace) Files

Adds all selected files and automatically overwrites any files that are already in the archive.

Freshen Existing Files

Only the selected files that are more recent than those already in the archive will be replaced.    Does not add 
any new files to the archive regardless if they are selected or not.

Update(and Add) Files

Same action as freshen existing files, but also adds any specified files, that are NOT already in the archive.

Move Files

Moves the specified files to the archive, removing them permenantly from the specified folder. 

Note:    If an error is encountered during archive creation, the specified files may be lost entirely during this 
operation.    Be careful when selecting this action.

Compression:

Determines the type of compression that will be used on the files being added to the archive.

Normal

Compresses files into archive at a normal compression rate.

Maximum(Slowest)

Compresses files into archive at a the maximum compression rate.    This compression method can be fairly 
slow with large archives.

Fast

Compresses files into archive at a fast compression rate.    The level of compression is just below the normal 
rate, meaning the stored files will be somewhat larger than if the normal compression rate was used.

Very Fast

Compresses files into archive at the quickest compression rate.    The level of compression is the lowest of the 
four settings so the stored files will be somewhat larger than if the fast compression rate was used.

None

Stores files in the archive as is.    Does not use any compression at all.    Most archives that are stored within 



your archive will be stored using this method as they have already been compressed and any further 
compression would be slow and save very little space, if any.

Drive:    Allows you to choose which drive the files are located on

Folders:    Allows you to select the folder that the files are located in

File Listing:    Allows you to select individual files from the listing.

Note:    You can select an individual file by clicking it.    You can select multiple files by either holding your 
shift key and clicking the appropriate section of files, or holding your control key and selecting files, one at a 
time from the listing.    Choosing the select all files button will select all the files in the current folder for you.

Select all Files:

Allows you to quickly select all files available in the current folder listing.    Uncheck this to deselect all files.

Show All Files:

Allows all files in the current folder to be listed in the available file listing.    When this is not selected, only 
normal files will be displayed.    Check this option to show 'Hidden & System' files in the listing as well.    
Uncheck this option to hide those files again.

Recurse Folders:    The Recurse Folders check box determines whether QuikZip recursively traverses all 
folders underneath the specified folder when looking for files to add.    This provides an easy way to backup all 
files underneath the current folder.

Note:    Care should be taken when selecting this option as folder names are discarded if the save folder info 
option is not selected in conjunction with this option.    Meaning that only the files in folder below the current 
folder will be added to the archive and not the sub folder info.    If there are two files of the same name, QuikZip 
will report an error and the current operation will be aborted because it cannot add two files with the same 
name to an archive unless they are stored in seperate folders within the archive.

Save Folder Info:    The Save Folder Info causes QuikZip to store any folder path information, allowing the 
archive to be created exactly as the folder is.

Note:    To restore a branch of a folder added with the save folder info option, be sure to select the Use 
Folder Names check box when    extracting the archive.    This option is set 'on' by default.

Password:    Allows you to password protect files being added.    See passwords for more information.

When creating new archives, if the archive is being written to removable media, such as a floppy disk, then 
QuikZip will ask you if you wish to write the new archive in Multiple Disk Mode.    See this section for more 
information.



Deleting Files
This option allows you to delete a file from within an archive without extracting the entire archive.    After 
selecting a file, this option is also available by right clicking on the selected file, bringing up the file popup 
menu. 

QuikZip will confirm that you wish to delete the selected file before proceeding.    Once confirmed, the file will be 
deleted from the currently opened archive.

Note:    Files cannot be deleted from archives created in Multiple Disk Mode.

Also, when deleting a file from a current open archive that is a Self-Extracting archive, delete operations can 
take considerably longer as opposed to Zip archive deletions.



Errors & Other Problems
Some typical error messages that you can encounter in QuikZip Deluxe when working with archives:

Error:    File is compressed with unknown compression method.

This error can occur when the archive is compressed with another compression utility other than a ZIP utility, 
but the archive is named as a ZIP archive.    It can also occur when the ZIP archive is compressed with a 
version of PKZIP from PKWARE, prior to v2.0.    This is a very early version of PZKIP and should be 
encountered very rarely if at all.

Error:    File has a bad CRC.

This error occurs when the file being processed has a bad packed CRC value.

Error:    Unable to open file.

This error occurs when the file being processed cannot be opened, usually due to corruption.

Error:    File is corrupt.

Again, this error occurs when the file being processed cannot be opened, usually due to corruption.

Error:    File not found.

This error usually occurs when you have defined files to be extracted using wildcards and no files following 
your defined wildcard string are found.    For example, defining *.TXT to be extracted from an archive that does 
not contain any .TXT files.

Error:    Windows informs you that QuikZip has caused a 'General Protection Fault' and that the program will be 
shut down.

This error can occur if a large operation is cancelled with QuikZip operating on a slow end 486 system and only 
8 MB of ram.    QuikZip should be run on a system that has at least 16 MB of ram installed or more.    Avoid this 
problem on low end systems by not cancelling large operations.



Extracting Archives 

This option allows you to extract the currently opened archive.    The following options are available to you 
when extracting:

Note:    By default, the last folder that you extracted to is automatically set for you to extract to again.    You 
can change this by selecting the appropriate folder in the folder tree listing.

Type of Extraction

Selected Files

You can select files from the currently opened archive before choosing the extraction option.    Select individual 
files by clicking the checkbox next to the file name.    If any files ARE selected, this option will be automatically 
chosen for you and only the selected files will be extracted.    You have the option though to change this 
selection to either of the options below at any time.

If you choose to extract only files you have selected from the archive listing, those files will be dimmed once 
they have been extracted to show you which files have already been extracted from the open archive.

All Files

Extracts entire contents of the archive, regardless if any files are currently selected.

Files

Allows you to type in a 'DOS' style selection of files to be extracted from the archive.    For example, if you 
wished to extract all of the '.TXT' files from the open archive, choose this option and type in the *.TXT.    Only 
files with a '.TXT' extention will be extracted from the archive.    If no files based on your windcard selection are 
found, an error occurs.

Overwrite Existing Files

If any of the extracted files already reside in the selected destination folder, they will be automatically 
overwritten with the files from the archive.

Use Folder Names

Determines whether QuikZip will use folder names (also known as path names) stored in the archive.    You will 
probably want to check this option for most extract operations.    If this option is checked any folder names 
stored in the archive will be appended to the selected destination folder when appropriate.    If this option is not 
checked all files will be extracted to the same folder, regardless of any folder names in the archive.

For example, if the selected destination folder is "c:\temp", the file stored as "temp2\readme.txt" will be 
extracted to the folder "c:\temp\temp2".

Note:    If any of the files you are attempting to extract have been password protected, you will need to enter 
the password before it is extracted.    See passwords for more information.



Fixing Archives
This option allows you to attempt to fix a damaged archive.    Archives can become corrupt for various reasons, 
including internet transfer.

There are two mode settings when an archive is chosen to be fixed:

Non Agressive Mode

This mode is the best choice for most fix operations and is the fastest of the modes.

Aggressive Mode

This mode can be used if the Non Agressive mode failed to fix the archive.    This mode is much slower that the 
Non Agressive mode.

Non Agressive mode is set by default.

QuikZip will inform you as to the fix being successful or not and will also inform you if it is skipping any files that 
cannot be recovered in the archive.

Note:    The Fix Damaged Archive option is not always successful, but it can usually fix small archive 
problems.

The Fix option is not available if the archive was created using Multiple Disk Mode.



Install Option

This option allows you to automatically install a program that is contained in an archive.    If the archive contains 
a 'SETUP.EXE' file or a 'INSTALL.EXE' file, the above toolbar button will become available, as well as the 
'Install' option under the Options menu.    You can also select the 'INSTALL.EXE' or 'SETUP.EXE' file from the 
listing.    After selecting the file, this option is also available by right clicking on the selected file, bringing up the 
file popup menu.

When you choose this option, QuikZip will extract the archive to it's temporary directory and automatically run 
the install program for you.

Note:      When this option is selected, QuikZip will search the temporarily extracted contents for the first 
'INSTALL.EXE' or 'SETUP.EXE' file it finds.    QuikZip will always run the 'INSTALL.EXE' if found, otherwise it 
will search for and attempt to run the 'SETUP.EXE' file. 

If the archive contains more than 1 of the above mentioned files and you wish to run one of these files that is 
stored later in the archive listing, you must extract the archive yourself and run the appropriate program.    
When you exit QuikZip, any extracted files still left in the QuikZip temporary directory will be automatically 
removed for you.



Mailing Archives

This option allows you to attach and mail the current opened archive.    This option greatly depends on your 
system configuration where MAPI (messaging application program interface) in Windows is concerned.

The message subject will automatically be entered for you as the archive folder and name, while the archive 
will be automatically attached to the message.

Note:    If you are unsure as to MAPI operation, please consult your Windows documentation.



Misc. Information
QuikZip Associations

When installed, if you chose the 'Typical' installation, QuikZip will automatically install itself as your default ZIP 
program.    This means that listed ZIP or Exe archives, in Windows Explorer for example will be shown with the 
QuikZip icon and be listed as a 'QuikZip File'.    This enables you to simply double click or right click and choose 
'Open' to open a ZIP or EXE archive in QuikZip.

QuikZip Temporary Folder

QuikZip automatically creates and maintains a temporary folder off of the main QuikZip folder call 'TEMP'.    
This folder is for temporary extraction operations such as viewing files, running files, scanning files and 
installing programs.    This folder is cleaned up each time you enter QuikZip and when you exit QuikZip.

QuikZip Archive Listing

When a Zip or Exe file is open in the QuikZip environment and you are viewing the contents of the archive 
there are a couple of features to note. 

If the option is set, under the 'Configuration Settings', hovering your mouse above a file will select it 
automatically.

The order of the listing headers can be easily rearranged by simply clicking the required column header and 
dragging it to the desired position.    For example:    If you wanted the 'Size' of the files within the archive listed 
first instead of the file name, you can select the 'Size' column header and drag it to the over to the 'Filename' 
position.    This will move the entire column listing in front of the 'Filename' column.

Note:    QuikZip will always restore the default positions for the listing when it is started again.



Multiple Disk Mode
When a new archive is being created, if the archive is being written to removable media, such as a floppy disk 
drive, QuikZip will ask you if the archive will require Multiple Disk Mode.    Meaning that the intended archive will 
require more room than 1 disk can provide.

QuikZip looks at the drive letter when determining if it should prompt for Multiple Disk Mode or not.    If it sees 
that the drive being witten to is "A:" or "B:", then it will prompt you for Multiple Disk Mode or not.    99% of users 
have their floppy disk drive on drive A or drive B.

If you set Multiple Disk Mode to 'yes', then QuikZip will prompt you if you wish to clear any existing contents on 
the disks being written to, before writing the new contents.

QuikZip will take care of creating the archive across multiple disks and will prompt you whenever a new disk is 
required to write to.

Features Unavailable in Multiple Disk Mode:

The following features are unavailable in Multiple Disk Mode:

Adding Files to Existing Archive
Adding Comments
Inserting Verifi System
Updating the Archive Date
Deleting Files
Sending Files to the Recycle Bin
Fixing Archive



Opening Archives

This option allows you to select an archive (Zip or Exe) to open.    You will then be able to work with the archive 
as it's contents are displayed to you on the screen.    The following file attributes are automatically shown for 
each file in the archive:

File Name

The name of the file.    If the file is stored with path information, that will also be shown.

Size

The original size of the file.

Stored

The compressed size of the file.

Ratio

The ratio that the file is stored at.    For example, a file ratio might be '70%'.

Attribute

The stored file main attribute.    This field will be blank for most files, while 'Hidden' or 'System' will be listed 
here if the file has that attribute.

Date/Time

The file date and time attributes.

Method

The method in which the file was stored to the archive.    This will be blank for compressed files within the 
archive, while it will display 'None' if the file was stored with no compression.

Encrypted

Shows if the file is encrypted or not.    Password protected files within the archive will display 'Yes' in this field.

CRC

The CRC value of the stored file.    CRC is defined as:    Cyclic Redundancy Check. The CRC is a 32-bit 
checksum system that is used to verify the integrity of data. The Zip archive format calculates the 32-bit CRC of 
a file before adding it to the archive, then stores the CRC in the archive along with the file. When a file is 
extracted, the CRC is calculated on the extracted file and compared with the CRC of the original file. If the 
CRCs are the same, then the extracted file is very probably identical to the original file, because the 32-bit CRC 
is able to detect single bit variations even in the largest files.

Note:    If a file cannot be read properly due to corruption, the file attributes for that file may be missing.

Additional Information

You can resize any of the columns within the file listing by placing your mouse between any of the column 



headings and dragging the column to the desired size.    This is particularly useful when files are stored with 
folder information, allowing you to resize the file name column to see the full file information.

By right clicking on a file in the current archive listing, you can then produce the QuikZip quick Right Click 
menu.



Opening Recent Archives
QuikZip Deluxe automatically keeps track of the last four archives you have either opened or created.    This 
files are listed on the 'File' menu, under the 'Exit' option, if available.

You can quickly open a recent archive by selecting it from the listing, either by the hot key number or clicking 
the item you wish to open.

When the list is full, QuikZip will replace the first item with the newly opened or created archive name and path 
and go through the listing once again.



QuikZip Deluxe Order Form

Use the 'Print' command to print the following order form.    If paying by credit card, ensure the credit card 
information is entered, otherwise ensure the cheque or money order is made payable to AVANTRIX Inc.    All 
prices below are in U.S. Funds.

Send the form along with your payment to:

AVANTRIX Inc.
Suite #335, 11215 Jasper Avenue
Edmonton, Alberta
Canada    T5K 0L5

QUIKZIP DELUXE ORDER FORM

QuikZip Deluxe _____ at $19.95 each = __________

QuikZip Deluxe Multiple Site Licenses:

2 to 9 computers: _____ at $16.95 each = __________
10 to 24 computers: _____ at $12.95 each = __________
25+ computers: _____ at $9.95 each = __________

Canadian Customers add 7% G.S.T. tax: __________

Total payment: __________

Date: __________________________________________________

Credit Card: [      ] MasterCard    [      ] Visa    [      ] American Express    [      ] JCB
[      ] Discover/Novus

Credit Card #: __________________________________________________

Expiration Date: __________________________________________________

Name On Card: __________________________________________________

Signature: __________________________________________________

Name: __________________________________________________

Company: __________________________________________________

Billing Address: __________________________________________________

City, State, Zip: __________________________________________________

Country:__________________________________________________

Day Phone: __________________________________________________



E-Mail address: __________________________________________________

How did you obtain your copy of QuikZip Deluxe?   

_______________________________________________________________

_______________________________________________________________



Passwords
Passwords can be used when creating new archives or adding files to an existing archive.    They may also be 
required if an archive you are attempting to extract has been password protected.

Password Protecting Files

Select the 'Password' button when adding files to a new or existing archive to password protect the files.

Note:    If multiple files are being added to a new or existing archive at one time and a password is entered, 
ALL of the added files will require the password be entered by the receiving party that is extracting the archive. 
Files can be given individual passwords when they are added to the archive one at a time.

Required Passwords

When extracting a file or files from an archive that require you enter the password, the password must be 
provided before the file can be extracted or viewed.    If the entered password is incorrect, the password prompt 
will be shown to your again.    The file name that requires the password will be displayed to you as well. 

You also have the option to skip the file if you do not know the password.    QuikZip will then move onto the next 
file within the archive. 

If all of the files within the archive are password protected with a single password, you will be prompted for the 
password only once and QuikZip will apply that password to the rest of the files automatically.    If the required 
password is incorrect or not entered, the archive or file cannot be extracted.



Purchasing QuikZip Deluxe

 

Purchasing the evaluation version of QuikZip Deluxe enables you to use the program beyond the 20 program 
entries as well as enabling your name or your company name for the Verifi System.

Licensed users can always purchase additional copies of QuikZip Deluxe at any time.

A single user site license (U.S. Funds) is priced at only:

$19.95

Order by Phone using your Visa, MasterCard, American Express, Discover/Novus or JCB card:

Toll Free U.S. & Canada 1-877-448-1491
International 1-780-448-1491

Order online at the AVANTRIX Web Site using a secured server:

Visit us on the InterNet at: http://www.avantrix.com

You can also print the order form and send it along with a cheque, money order or credit card information.    
Multiple site license pricing is available here.

Contact AVANTRIX Inc.

You can contact AVANTRIX at the above phone number or by E-Mail at: 

Sales: sales@avantrix.com
Support: support@avantrix.com



QuikZip Configuration Menu
Below you will find the available options for this menu.    Underlined options require further explanation and 
have a topic of their own.    Click the link to view that option's details.

Font

This option allows you to change the font attributes for the archive file listing display.    You have a choice of all 
system fonts, italics, bold, etc.

Configuration Settings

Sound



QuikZip Deluxe FAQ
Frequently Asked Questions

Here are some of the frequently asked questions about QuikZip and answers.    Before contacting JCL 
Developments for support, you may find the answer to your question here.

Question:    Everytime I add files to an archive, QuikZip asks me if I want to add a comment to the archive and 
also prompts me to add the 'Verifi System'.    This drives me crazy.    How can I change this?

Answer:    Under the Options menu, you'll find Configuration Settings.    The settings for archive comments and 
the 'Verifi System' are included here.    If you are being prompted every time then the settings will be set to 
prompt you.    Change the settings to what you want here.

Question:    Whenever I delete a file from or add files to an archive that is 'Verifi System' protected, the 
'VERIFI.DAT' file is removed along with the protection.    Why is that?

Answer:    Once any files are deleted from an archive or new files are added, the initial 'Verifi System' 
protection is then compromised and becomes essentially useless.    It will always report tampering after either 
of these actions.    QuikZip removes the protection file and the 'Verifi System' overall from the archive for you 
automatically.

After you have completed working with the open archive, simply add the "Verifi System' back into it.    This will 
ensure that the protection is current and operable.

Question:    I want to add files from many different folders to an archive.    How do I do this?

Answer:    There are two ways that you can do this.    Move all of the files you want to add to the archive into 
one temporary folder, or you can add files from each folder, one folder at a time.    Files can be added to an 
archive at any time.

Question:    QuikZip keeps on prompting me for a password on the same file over and over again.

Answer:    This means that the file in question is Password Protected and requires a password to either be 
viewed or extracted.    If an incorrect password or no password at all is entered for the file, QuikZip will prompt 
you again for the password.    If you do not know the password, then select 'Skip' from the password screen and 
that file will not be extracted.

Archives can contain files that require seperate passwords for each file or one password for the entire archive. 
If the archive is protected by one password, QuikZip will only prompt you once for this password and apply it to 
any other files automatically protected by it.

Question:    When I have an archive open and choose the Fix    or Test option, QuikZip works with the currently 
open archive.    What if I want to fix or test a different archive?

Answer:    QuikZip assumes that you want to fix or test any currently open archive.    If you want to select a 
different archive, then choose the Close Archive option from the File menu first.

Question:    How does QuikZip decide which directories it starts in whenever I want to open a new archive or 
other operations that require me to choose files?

Answer:    QuikZip keeps track of where you have been and stores the last folder information in the 
'QUIKZIP.CFG' file.    Whenever you choose to work with an archive, QuikZip will change to the last folder 
pertaining to that operation for you automatically.

Question:    Whenever I select the recurse option when adding files to an archive, QuikZip only stores the files 
from the folders and not the folder names.



Answer:    The recurse option is meant to do just that.    If a main folder is chosen with numerous folders within 
that main folder, QuikZip will add all of the files within all of the folders to your archive.    It does not add the sub 
folders to the archive.    Use the save folder info option to do this.

Question:    Whenever I right click on a file and choose extract to extract only that file, the Selected 
File(s)/Folders option is dimmed from the extraction screen.    Isn't that file I right clicked on, selected?

Answer:    No.    If you want to extract an individual file or number of files, you must click the corresponding 
checkmark next to the files you want to extract from the archive. The individual file selection right click menu 
does not apply to the extract option.    It is merely there for a quick way to call the extraction method.



QuikZip Deluxe Sound

This option allows you to toggle QuikZip Deluxe sound effects on or off.    When the menu item has a 
checkmark beside it, sound effects are on.    The default is on.

Note:    QuikZip Deluxe will check at startup to ensure your computer has the capability of playing sound 
effects.    If the system reports back as not having a sound card, the 'Sound' option will be dimmed and 
unavailable.

All of the QuikZip Deluxe sound effects reside in the QuikZip\Sounds folder.    Here is a breakdown of each 
sound and when it is played.    You can customize the sounds if you wish, by simply replacing any existing 'Wav' 
files with new ones.    Ensure you name a new file the same name as the existing one being replaced.

Sound Breakdown

Click.Wav - Played whenever one of the large option buttons are clicked.

Delete.Wav - Played whenever a file is deleted from an open archive.

Error.Wav - Played whenever most errors are encountered.

Exit.Wav - Played whenever QuikZip is exited.

Mail.Wav - Played when the 'Mail' option is chosen.

NoFT.Wav - Played whenever a 'Test' or 'Repair' option is unsuccessful.

Open.Wav - Played whenever an archive has finished opening.

Welcome.Wav - Played after the main screen has initially started.

Zip.Wav - Played whenever an archive creation process has been completed.



QuikZip File Menu
Below you will find the available options for this menu.    Underlined options require further explanation and 
have a topic of their own.    Click the link to view that option's details.

New Archive

Open Archive

Extract Archive

Close Archive

Allows you to close the currently open archive and remove the archive contents from the listing.

Mail Archive

Run Windows Explorer

Allows you to quickly run Windows Explorer, while still in the QuikZip environment.

Send to System Tray

QuikZip Deluxe ZipWizard

Exit QuikZip

Allows you to exit QuikZip at any time.



QuikZip Help Menu
Below you will find the available options for this menu.    Underlined options require further explanation and 
have a topic of their own.    Click the link to view that option's details.

Help Contents

Display this file.

QuikZip Deluxe Tips

View QuikZip Tips regarding program operation.

About QuikZip Deluxe

Copyright and other information screen about QuikZip Deluxe.

JCL Developments Web Site

Shortcut to the home of JCL Developments on the Internet.

QuikZip Deluxe Home Site

Shortcut to the home of QuikZip Deluxe on the Internet.

Order QuikZip Deluxe Online

Shortcut to order QuikZip Deluxe online by credit card via a secure server.

Note:    The above three options require an Internet connection.    If your system is configured correctly, your 
default Web Browser will load automatically and be directed to the above locations.



QuikZip Options Menu
Below you will find the available options for this menu.    Underlined options require further explanation and 
have a topic of their own.    Click the link to view that option's details.

Add Files to Archive

Add Comment to Archive

Insert Verifi System

Update Archive Date

View/Run Selected File

Delete Selected File

Send Selected File to Recycle Bin

Create Shortcut for Selected File

Run Install Program

Virus Scan Archive

Test Archive

Fix Damaged Archive

Convert Zip to Self-Extractor



QuikZip Deluxe Program Overview
Copyright © 1998, 1999 AVANTRIX Inc.

QuikZip Deluxe allows you to easily extract and create ZIP or Self-Extracting EXE files.    QuikZip is compatible 
with all other ZIP programs, allowing you to work with already existing archives that you may have or obtain.

Here are some of the many features you will find in QuikZip Deluxe:

Quickly create new ZIP archives
Quickly create new Self-Extracting archives
Easily extract existing archives
Extract individual files
View archived files
Fix damaged archives
Test Archives before extracting
Password protect archives or single files
Mail attach archives using MAPI
Add or view archive comments
Virus Scan Archives
Automatic Program Install Support
Verifi System to protect your archives



Verifi System
The QuikZip Verifi System enables users to ensure their archives have not been tampered with and that all 
files originally included in the archive are there for the end user.

The Verifi System works on several different scales, based on the contents of the archive created.    You can 
choose to add the Verifi System to an archive at any time.

If you have set QuikZip to prompt you for the addition of the Verifi System at the Configuration Settings menu, 
when a new archive is created and files are added, or files are added to an open archive, QuikZip will ask you if 
you wish to add the Verifi System to the archive if it is not already enabled.

If the Verifi System is added, once the archive is extracted in QuikZip, the end user will be informed if the 
archive is original or has been possibly tampered with.    Something as simple as removing a 2k file will throw 
off the Verifi System's integrity and the archive will be reported as not original.

The Verifi System only reports the archive's integrity upon extraction.    Opening or testing archives does not 
report the Verifi System findings.    Also, the Verifi System will not report the archive's integrity unless ALL 
files are extracted.

Here are some special concerns where the Verifi System is concerned:

Adding files or deleting files will always automatically remove the Verifi System from the archive if it is enabled. 
Adding or deleting changes the archive integrity, so the old Verifi System would report tampering if left intact.

If you wish to work with an archive that is Verifi System enabled, QuikZip will remove the Verifi System file 
automatically, allow you to make your changes without further prompting and then you can add the Verifi 
System back into the archive, reflecting any changes.

The Verifi System will report the original creator of the archive when extracted in QuikZip.    This name is 
ALWAYS the licensed name from QuikZip.    In evaluation versions, the name will be reported as 'Evaluation 
Version'.    Purchasing QuikZip allows this field to contain your name or your company name.    Releasing an 
archive with the Verifi System enabled from an evaluation version would not protect the archive very well, as 
anyone could tamper with the archive and add the Verifi System protection again to say 'Evaluation Version'.

Note:    Although efforts were made to make the Verifi System hard to hack into, this does not mean it 
cannot be done.    In most cases, the Verifi System is a great way to ensure the end user gets the original 
archive, but it should not be counted on to provide ultimate security.

The Verifi System cannot be added to archives created in Multiple Disk Mode or Self-Extracting (.EXE) 
archives.



Right Click Menu

The right click menu appears when you are working with an open archive, and click a file with your right mouse 
button.    The menu appears at the location of your mouse.

The options available when right clicking on a file name are:

Delete
Send to Recycle Bin
View/Run
Install
Extract (Checked Files)
Create Shortcut
Properties

The 'Install' option will only be available if the selected file is listed as 'INSTALL.EXE' or 'SETUP.EXE'.    The 
'View' & 'Create Shortcut' options will not be available when a stored folder is selected.    All of these options, 
minus the 'Properties' option, are available under the Options menu or from the main toolbar menu as well,.

Note:    When selecting the Extract option from the Right Click Menu, it applies to those files that have been 
tagged for extraction by clicking the appropriate checkbox.    It has nothing to do with the current file you have 
selected.    The extract option was put here for quick access to extract the checked files.

The 'Delete' and 'Send to Recycle Bin' options are not available if archive was created using Multiple Disk 
Mode.



Scan Option
Choosing this option with an open archive allows you to scan the contents of the archive using an externally 
defined virus scanner.    You can setup your virus scanner location and command line switches under the 
configuration settings menu option.

When this option is chosen, QuikZip will extract the archive to it's temporary directory and run your defined 
virus scanner, scanning the archive contents.

Note:      QuikZip has no control over your chosen virus scanner operation.    QuikZip will simply pass the 
extracted files to the virus scanner to be scanned, along with any command line switches defined.    When you 
exit QuikZip, any extracted files still left in the QuikZip temporary directory will be automatically removed for 
you.



Self-Extracting Archives
Self-Extracting archives store files much the same way as Zip archives.    The major difference between Self-
Extracting archives and Zip archives, is their ability to be run as a program, without the need for an archive 
utility to open or extract the files.

Creating Self-Extracting archives is as easy as creating Zip archives.    Most of the operations remain the same 
when creating Self-Extracting archives.    These archives, by default are given the extension of '.EXE' as 
opposed to '.ZIP'.    This way, the end user's system sees the archive as an actual program.

Self-Extracting archives created using QuikZip, by default will always:

Prompt the end user for extraction folder location
Prompt the end user to overwrite existing files
Show the extraction progress

Note:    If you need more control over the way a Self-Extracting archive runs, then consider looking at 
another program created by JCL Developments:    Package Plus.    This program is available via our Web Site 
for free evaluation download.

Once you have created a Self-Extracting archive, you can simply distribute the '.EXE' file to the receiving party.

Self-Extracting archives also support Multiple Disk Spanning as well, although some features available with Zip 
archives are not available when creating Self-Extracting archives.    Features unavailable when creating or 
working with Self-Extracting archives:

Archive Comments
Verifi System Protection



Send to System Tray

This option allows you to send QuikZip Deluxe to the system tray temporarily.    Internet users will find this 
option especially handy when surfing and downloading archives.    When QuikZip is sitting in your system tray, 
simply right click on the QuikZip icon to choose from the available options:

Restore QuikZip Deluxe
Exit QuikZip Deluxe



Sending Files to the Recycle Bin
By selecting this option from the Options menu or the Right Click menu, you will be able to extract the chosen 
file and send it to the Windows Recycle Bin instead of using the Delete option and deleting it entirely from the 
archive.

This option is a good choice if you wish to remove the file from the archive, but are unsure if you will want the 
file again.    The Windows Recycle Bin allows for you to restore a file that has been deleted.

Note:    If you do decide to restore a file that has been sent to the Recycle Bin by QuikZip, keep in mind that 
the file will be restored to it's original location by Windows, which will be:

QuikZip Folder\Temp

QuikZip cleans up this folder on a regular basis, so if you restore a file, you should move it to another folder, or 
QuikZip will delete it.

Note:    Files cannot be send to the Recycle Bin from archives created in Multiple Disk Mode.

Also, when sending a file to the Recycle Bin from a current open archive that is a Self-Extracting archive, 
operations can take considerably longer as opposed to Zip archive deletions.



System Requirements
The below requirements must be met in order to run QuikZip Deluxe on your system properly and effectively:

Computer Requirements:

Minimum:

Pentium 75 MHz
8 MB Ram
SVGA Display  - 256 Colors or better
Sound Device (To enable QuikZip Sounds)

Suggested:

Pentium 166 MHz
16 - 32 MB Ram
SVGA Display (Hi Color)
Sound Device

Installed, QuikZip requires approx. 8 MB of hard drive space.    Although 8 MB of RAM is a minimum 
requirement, 16 MB is highly suggested.

Operating System Requirements:

Windows 95/98
Windows NT 4.0+



Testing Archives
This option allows you to test an archive to ensure it's integrity is intact.    You can choose this option before 
opening or extracting it, or you may wish to test the integrity of a newly created archive.



Updating Archive Date
This option allows you to update the currently open archive's date to reflect the date of the newest file within 
the archive.

QuikZip will confirm that you wish to update the current archive date before proceeding.

This option is helpful when new files are added to an old archive and you wish to make the archive's date 
newer.

Note:    Archive dates cannot be updated if the archive was created in Multiple Disk Mode.



Viewing File Properties

By selecting this option from the Right Click menu, you will be able to view the properties of the currently 
selected file.

The properties contain the same information that is presented in the screen listing, although this option allows 
you to see them together and quickly.



Viewing/Running Files

This option allows you to view or run a file from within an archive without extracting the entire archive.    This 
option is also available by right clicking on the selected file, bringing up the file popup menu.    The checkbox is 
only used for multiple extraction purposes.

You will then be shown the view screen which allows you to choose from the following options:

Associated Program

QuikZip will automatically determine the associated program on your system, that can either view or run the 
selected file, if any and use that program.    For example, selecting a ".DOC" file and choosing this option, will 
automatically load the file into 'Microsoft Word' if it is available on your system.    A ".BMP" file selection would 
show you the file in 'MS PAINT'.    A '.TXT' file would show you the file in 'NOTEPAD'.

Using this option will also automatically run an '.EXE' or 'HLP' file for you.    It is important to note though, if the 
selected .EXE file requires any other files in the archive, it of course will not run properly.    It is a good idea to 
extract the entire archive before running any files.

If no program is available on your system that is associated with the selected file, QuikZip will inform you and 
abort the viewing process.

Windows NotePad

Allows you to view the selected file in 'NOTEPAD', regardless of the file extension.    If the file is too large to be 
viewed in 'NOTEPAD', QuikZip will inform you an ask if you wish to use 'WORDPAD' instead.

QuikZip Internal Viewer

Allows you to view the selected file with the QuikZip 'Internal Viewer', regardless of the file extension.



ZipWizard Step 1

Step 1 of the ZipWizard allows you to select the type of archive you would like to create:

ZIP Archive
EXE Archive

You also define the name of your archive in Step 1 of the ZipWizard. 

Archive Name

The ZipWizard will automatically append the '.ZIP' or '.EXE' filename extenstion to your archive.    There is no 
need to enter it here.

Step 2 - Archive Options & Comment



ZipWizard Step 2

Step 2 of the ZipWizard allows you to set certain options and decide if your archive will require a comment or 
not.

Compression Style

Choose the compression style you want for this archive.    Most users will find the default 'Normal' to be fine and 
can leave the setting as is. 

Normal - Compresses files into archive at a normal compression rate.

Maximum(Slowest) - Compresses files into archive at a the maximum compression rate.    This compression 
method can be fairly slow with large archives.

Fast - Compresses files into archive at a fast compression rate.    The level of compression is just below the 
normal rate, meaning the stored files will be somewhat larger than if the normal compression rate was used.

Very Fast - Compresses files into archive at the quickest compression rate.    The level of compression is the 
lowest of the four settings so the stored files will be somewhat larger than if the fast compression rate was 
used.

None - Stores files in the archive as is.    Does not use any compression at all.    Most archives that are stored 
within your archive will be stored using this method as they have already been compressed and any further 
compression would be slow and save very little space, if any.

Save Folder Information when Adding Files

The Save Folder Information option causes the ZipWizard to store any folder path information for each file 
added to the archive.

Add Archive Comment to the Archive

Allows you to define text as an archive comment.    The text comment will be displayed to the user when the 
archive is opened, as long as the user has their configuration set to do so.

Comments can contain any ASCII characters and can be a maximum of 255 characters long.

Comments will not be added to archives that are being created across multiple disks or to Self-Extracting 
(.EXE) archives. 

If you have set the archive to be created as an .EXE archive, the Add a Comment to the Archive option will not 
be available.

Step 3 - Determine Files to Add



ZipWizard Step 3

Step 3 of the ZipWizard allows you to define the files you want included in your archive. 

Drive Drop Down Box

This drop down box allows you to change to a different drive, depending on the location of the files you want to 
add.

Folders Selection Box

This selection box, allows you to select the folder where your files are located.    Simply double click the folder 
you want to list available file for.

Files Selection Box

This selection box allows you to select file to add to your archive.    Double clicking any file will automatically 
add it to your Files to be Added listing.

Files to be Added Listing

This listing features all of the files you have selected to add to your archive.    If you wish to remove a file from 
the listing, right click the file you want to remove and select the 'Remove Selected File' popup option.

The full path and file name of any added files will be listed here.    You can add as many files as you wish, from 
as many different folders or drives as you wish.

Step 4 - Creation Locations & Creation



ZipWizard Step 4

Step 4 (Final Step) of the ZipWizard allows you to determine where your archive will be created and will allow 
you to actually create the archive.

Creation Location

The creation location tree listing acts much like Windows Explorer does.    Here you can select the location 
where you want your archive created.    You can either select a drive, such as a floppy drive, or a folder on a 
hard drive.

Create Archive Button

After selecting an appropriate location, this button will begin creation of your archive.    You will be presented 
with a status screen, informing you as to the current status of the creation.

This button will not be available if you have not selected any files to add to your archive.

If you have chosen to create your archive on a floppy drive (Drive A or Drive B), then the ZipWizard will ask you 
if you wish to enable 'Multiple Disk Mode' when creating the archive, if the size of the files may exceed the size 
of a standard floppy disk.    Setting this option to 'On' will enable the ZipWizard to span multiple disks when 
creating the archive.

If you have enabled 'Multiple Disk Mode', you will also have the option to clear any existing contents of disks 
before writing to them. 

The ZipWizard will then take care of spanning multiple disks with your archive and will prompt you when the 
next disk needs to be entered.






